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1. GeoGIS2005 – General Description 

GeoGIS2005 is a general framework for managing technical databases. The system includes 
a number of functions especially made for geological, geotechnical and water technical data 
and jobs.   

GeoGIS2005 applies mainly to public institutions, consultants and contractors.  

Data may be viewed in data lists, graphs, documents and maps. The user may import/export 
data in a number of different formats. Especially worth mentioning is the correlation between 
GIS-systems such as MapInfo, ArcGIS, GIS Viewer and Google Earth.  

GeoGIS2005 is developed by RAMBØLL and is sold on a license basis. GeoGIS2005 is a fur-
ther development of the former GeoGIS2000. It is possible to access databases used in con-
nection with GeoGIS2000 from the GeoGIS2005 version. 

In GeoGIS2005 it is possible to visualise data from the Jupiter database, which is run and 
maintained by GEUS. The Jupiter database now includes geological, hydro geological and 
chemical groundwater data from everywhere in Denmark.  

    
Figure 1. Jupiter with typical data contractors and partners. 

GEUS Jupiter 

Regions 

Environmental centres 

Consultants 

Water supply 

Municipalities 

Contractors 



 

Ref. 4694001/GeoGIS2005_Manual_UK_20071205 2/49

 

2. User interface 

Data in GeoGIS2005 are listed in database windows. The user may open several database 
windows at a time. 

GeoGIS2005 displays data in a tree structure similar to the Windows Explorer. For each se-
lect made in the tree structure to the left, the corresponding data will show to the right. If 
there are sub-folders to the selected folder, data will show in a tabs structure.  

Figure 2. An example of a database window showing data from GeoGIS2005 - BRegister. To 
the left is the tree structure, to the right data in lists and tabs.   

Data grids, Graphs and Documents are the three main forms for showing data in the data-
base window. The documents may both be local documents or links to external pages on the 
Internet.  
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2.1 Windows and Viewing Data 
 
The windows are set up in the Meta database. See section 4. At installation, GeoGIS2005 
includes a ready set up meta database with the following applications: 
 
• GeoGIS  : Application for registering geotechnical data 
• JupiterXL  : Application for managing data from the GEUS Jupiter database 
• RMS   : Application for managing road survey data 
 
In general, it is not necessary to adjust the windows. If it proves necessary, adjusting should 
be made by a super-user. Changes may be discarded when new versions are installed.  
 

2.1.1 Datagrid 
 

 
Figure 3. An example of a window with a data grid with tabs. 
  
The panel to the left contains data in a list form (data grid). The panel to the right contains 
detailed data for the current row in the list to the left. The database fields to the right are 
divided into groups you open and close with “+” and “-”. In a similar way, the user may se-
lect fields to be hidden in the list by a click in the Hide column. 
 
The colours of the fields in the data grid describe the fields’ function, e.g.: 
 
• yellow fields indicate unique key fields 
• fields with blue text indicate links to other data, e.g. code lists 
• grey fields calculated data and other non editable fields 
• turquoise fields indicate changed data 
 
In addition to this, the different windows may have a special colour table.  
 
At the bottom of the right panel, you find a number of buttons for calling functions attached 
to the current data. 
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By use of the Ctrl key or a shortcut menu, you can call a number of standard functions for 
sorting, editing and setting up the layout. Shortcut keys are found to the right in the menu: 
 

 
Figure 4. Shortcut keys are found to the right in the menu. 
  
Menus and toolbars are described in detail in section 5. 
 
Code lists are managed through combo boxes or a code list selector. The user may select 
which type that is used in the extended detail window: 
 
Code lists by use of Combo boxes 
 

 
Figure 5. Code lists by use of Combo boxes. 
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Code lists by use of Selector 
 

 
Figure 6. Code lists by use of Selector. 
 
The Code List Selector is useful for managing long code lists and for fast editing. 
 
You produce the extended detail window by Ctrl+Shift+Z and refresh the window appearance 
by Ctrl+Shift+R. 
 
Maximisation 
 
You can maximise the separate windows so that the tree window and other windows, if re-
quired, are hidden by a click on the maximise button: 
 

 
Figure 7. Button for maximising window. 
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2.1.2 Graphs 
 
GeoGIS2005 includes a number of graphs that are used to get a quick survey of the data: 
• Time series of water soundings 
• Grain Size distributions 
 

 
Figure 8. Grain Size distributions. 
  
The graphs are defined in the Meta database. You may adjust the graphs by right clicking 
what you want to change. If you need larger control of the layout, it is easy to copy data to 
e.g. Excel, where there are more options for adjusting the layout.  
 
In the detail window, the user may turn the individual graphs on and off and indicate the 
insertion of the axes. By right clicking on the graph and select Toolbar, you get a large num-
ber of options for editing the data view: 
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Figure 9. An example of a graph where the Toolbar is selected. Here the data are shown in a 
table at the bottom of the image. 
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2.1.3 Documents 
 
External documents can be viewed in GeoGIS2005.  
 
The documents are expected to be standard formats that can be viewed in a Browser such as 
html, pdf, jpg, svg, excel, word, etc. 
 
Note, that documents do not have to be fixed files, but can also be dynamic pages that are 
called by the use of an URL with parameters. In this way GIS references from KMS, GEUS 
and others can be shown with appropriate coordinates as parameters.  
 
Besides, GeoGIS2005 contains a number of functions for drawing borehole logs, longitudinal 
sections and miscellaneous geotechnical lab tests. 
 
E.g. borehole logs from the central Jupiter database may be displayed in the form of external 
documents. A valid URL (external documents) or a path (local documents) identifies the 
documents.  
 
Other external documents in the Jupiter database can be shown in a similar way.  
 

 
Figure 10. An example of a borehole log viewed in GeoGIS2005. The viewer can be maxi-
mised for optimal view of the external/attached documents. 
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2.2 Data 
 
Data viewed in GeoGIS2005 may have several origins. Examples are GeoGIS databases used 
in connection with GeoGIS2000 and the Jupiter database at GEUS. 

Databases 
GeoGIS2005 may access several databases at a time. The databases may be placed locally 
on the user’s machine or network, in a client-server environment or hide behind a web ser-
vice. The user defines the connection to the different databases in the Database administra-
tor and is subsequently able to call the databases from the menu: 
 

 
Figure 11. Fast select of attached databases. 
 
Pages 
 
Access to a certain kind of database is divided into a number of “pages”. The pages are 
called from the systems main menu: 
 

 
Figure 12. Selecting database pages.  
 
Several pages belonging to the same or different databases can be viewed at the same time. 
 
 
Shortcuts 
 

 
Figure 13. Selecting shortcuts. 
 
If there is a particular item in the menu structure, which is often visited, the user may make 
a short cut for this item. Typical shortcuts can be: 
 
• A particular borehole 
• Newly entered samples 
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• a special user defined search 
 
“Last” indicates the menu used most recently. The shortcuts may refer to different data-
bases. You can enter a suitable guide text to each shortcut. You can also select a fixed short-
cut as “start up page”: 
 

 
Figure 14. Editing shortcuts. 
 
 

2.3 GIS – Interface 
 
As standard, GeoGIS2005 has a number of functions for exporting data to desktop GIS sys-
tems directly from the windows. This is made possible by showing data together with the 
relevant coordinates.  
 

 
Figure 15. Here geological data are grouped together with coordinates from the borehole, so 
data easily can be exported to GIS. 
 
The GIS export functions are called from the shortcut menu: 
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Figure 16. Direct GIS Export functions.  
 
GIS Export functions: 
 
• GIS start – Starts the selected GIS system. As most GIS systems have a long start-up 

procedure, it is more convenient to start the GIS system before you send data from 
GeoGIS2005. 

• GIS export – All table columns are exported. 
• GIS export selected - All selected table columns are exported. 
• GIS center selected – The current GIS window, which has focus is centred on the coordi-

nates in the selected rows. Markers circles are drawn, but data are not exported. 
 
The following GIS systems / GIS formats are supported: 
• ArcGIS 9.1 or later 
• MapInfo 8.0 or later 
• Google Earth 4.2 or later 
• GISViewer 
• Shape files 
 
The easiest way to select the present GIS system is by clicking the button in the system’s 
status bar: 
 

 
Figure 17. GIS button in the status bar.  
 
When you have exported data to GIS, you can use smaller applications in the GIS systems 
for: 
• looking up references in GeoGIS2005 
• selecting e.g. borings 
• defining longitudinal sections 
 

 
Figure 18. GeoGIS2005 toolbar in MapInfo. 
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You can also export data to GIS by way of the GIS module, which is used when exporting 
larger amounts of data, see section 3. 

3. Utilities 

GeoGIS2005 contains a number of standard tools that are used across the different database 
types:  
 

 
Figure 19.  Various standard tools in GeoGIS2005 
 
The Database Administrator is used for: 
• defining database access including user name and password specification 
• creating new local databases 
• updating and repairing (local) database 
• handling licenses 
 
Import, Export and Updating is used for: 
• importing and exporting data between databases and various file formats 
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• performing database check programs, e.g. to control that field codes are entered cor-
rectly 

• performing database updating scripts 
 
The GIS module is used for running large GIS export processes. The export processes can 
be executed in groups. The data may be exported to: 
• ArcGIS 9.1 or later 
• MapInfo 8.0 or later 
• Google Earth 4.2 or later 
• GISViewer 
• Shape files 
 

3.1 Database Administrator 
 

 
 

 
Figure 20. Database Administrator 
 
The Database Administrator is used for: 
• defining access to databases including user name and password specification. 
• creating new (local) databases 
• updating and repairing (local) databases 
• handling license conditions 
 

3.1.1 Open database – tab  
 
• Database Name Here the user can enter a short name for the database con-

nection. The name is used hereafter when the user wants to 
see the data.  

• Database Type Here the user enters the database type. The following data-
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base formats are supported: 
• Microsoft Access 
• SQL Server 
• Oracle 
• Webservice 
• Webservice – GEUS 

• Database Connect Here the connect parameters to the database are entered. The 
parameters are dependent on the database type. See below. 

• Database Format Here you enter the database format. Example formats are:  
• GeoGIS 
• JupiterXL 

• Database Page Default database page for this database. 
• Database User name User name for this database. If empty, the Windows user is 

used. 
• Database Password Password for this database. 

 
The connection to the database is defined once for all and saved - even if the program closes 
down. 
 
The user can save the settings by using GeoGIS2005 > Files > Save settings and send it to 
another user, who can import it by using GeoGIS2005 > Files > Import. 
 
If you want to connect to Microsoft Access, you click for selection of Microsoft Access data-
base file (.mdb) 
 
If you want to connect to SQLServer or Oracle you click for entering database connect prop-
erties: 
 

  
1. Select OLE DB Provider 2. Select Server and Database 

 
Figure 21. Indicating parameters for connecting to SQL Server and Oracle databases. 
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It is recommended that you use Windows NT integrated security, so the security is managed 
via the Windows user. By this method, the user can avoid entering user name and password 
in GeoGIS2005. 
 
If you want a connection via a web service, you enter the Internet address on the server and 
select the database:  
 

 
Figure 22. Selection of database in connection with web service.  
 
Connection to Jupiter at GEUS is done via a web service with the Internet address: 
www.jupiter.geus.dk. 
 

3.1.2 Create databases - Tab 
 

 
Figure 23.  Database Administrator functions for creating new databases. 
 
Here the user may: 
 
• Create new Microsoft Access databases. Enter file name and database format for the new 

database. 
• Print out a database definition file to use in SQL Server 2000 and SQL Server 2005. This 

file contains all necessary SQL expressions to create a SQL Server database e.g. by using 
SQL Server Enterprise Manager. 



 

Ref. 4694001/GeoGIS2005_Manual_UK_20071205 16/49

• Create a new Query database. Enter the database you want to connect to together with 
the file name of the Query database.  

 
A Query database is a Microsoft Access database with tables linked to the master database.  
The Query database enables the user to query SQL Server and Oracle databases using Micro-
soft Access queries. The active Query database is the one selected in the list.  The user may 

start access the database by pressing the icon:    in the toolbar. 
 

3.1.3 Repair databases - Tab 
 

 
Figure 24.  Database Administrator functions for repairing databases. 
 
The user may: 
 
• Repair Microsoft Access databases if the internal structure is damaged.  
• Check a database for new tables, fields and relations. 
• Update a database with new tables, fields and relations. 
• Prepare a new installation. 
 
When a user receives a new version of GeoGIS2005, new tables, fields and relations may 
have been added. The Check and Update functions make it possible to update existing data-
bases corresponding to the new database formats by first listing the necessary updates and 
then by adding them to the selected database. 
 
For SQL Server databases, it is possible to get the necessary update scripts printed out to a 
file, which afterwards may be executed in the database environment. 
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3.1.4 Licenses - Tab 
 

 
Figure 25.  Database Administrator functions for maintaining license numbers. 
 
When GeoGIS2005 is installed on a PC and executed for the first time, it is supplied with an 
installation number. The user must get corresponding license numbers for the various mod-
ules before the program can run. 
 
After entering Company Name, User Name and Mail Address and ticking off the required pro-
gram modules, the user may retrieve the license numbers using the internet by clicking “Get 
License No’s”.  
 
The first time the user retrieves license numbers, the possibility of using the program 1 
month free of charge is offered. When the user enters into a final license agreement, Ram-
bøll will update the license numbers, which the user can import again by clicking “Get Li-
cense No’s”. Under special circumstances, users may get license numbers sent by mail. The 
users enter the new license numbers themselves and finish by “Update License No’s”.  
 
The running version is checked by a click on “Get Updates”. If a new version is available, the 
page http://GeoGIS2005.ramboll.dk will start. From here, new updates can be downloaded.  
 
Each time the user starts the system and is connected to the internet, it will automatically 
check for new versions. If the version is outdated, the following button will show in the sys-
tem’s status bar: 
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A click on the “Update!” button gives access to the update page.  
 
 

3.2 Import, Export and Update 
 

  
 

 
Figure 26. The Import module. 
 
Import, Export and Update is used for: 
• importing and exporting data between databases and various file formats 
• executing database check programs, e.g. for checking that field codes are correctly 

specified 
• executing database updating scripts 
 
The user may specify: 
• From Database, i.e. the database or file from which data are imported 
• To Database, i.e. the database or file to which data are exported 
• The Parameters tab is used to specify certain parameters in connection with the indi-

vidual function 
• The Status tab shows continuously how much the individual function has calculated 
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You start the program by clicking the Execute button and stop it by clicking the Stop button 
in the Status bar: 
 

 
 
 

3.2.1 Geoform and GeoXML 
 
Import, Export and Update has a special function to read and write Geoform / GeoXML 
files used for exchange of especially geological and geotechnical information: 
 
Geoform Files 
 
 
#%, 
#COM %"DSB"%"DSB"%"Møntergade, 
(R&H kortnummer 1239),"%1%%False% 
#JOB %"DSB"%"012/90"%"Nyt oplæggerleje, Rødbyhavn"%%%"a"%%%%%%"UTM32ED50"%%%%%%%%19951004 120000%19951004 120000%%%"B"%"UK"%%"dev"%20040329 
111034%6%True%%%%%%%%%%%%%% 
#BOR %"DSB"%"012/90"%"B501"%"12/90-B501"%%%%%%%%19900502 
120000%"UTM32ED50"%651866%6058851%%"DNN"%2.74%%%%%0%17.6%%%%%%%%%%"GT"%"UK"%%%%%"0"%%%"dev"%20040329 051729%126%%%%%%%%%%%%%%%% 
#LAY %"DSB"%"012/90"%"B501"%0%7.25%"TC"%"A"%"LG/PG"%%482%%%% 
#LAY %"DSB"%"012/90"%"B501"%0%%"M"%%%%481%%%% 
#LAY %"DSB"%"012/90"%"B501"%0.6%%"M"%%%%483%%%% 
#LAY %"DSB"%"012/90"%"B501"%1.2%%"M"%%%%484%%%% 
#LAY %"DSB"%"012/90"%"B501"%2.3%%"M"%%%%485%%%% 
#LAY %"DSB"%"012/90"%"B501"%4.4%%"M"%%%%486%%%% 
#LAY %"DSB"%"012/90"%"B501"%6.3%%"M"%%%%487%%%% 
#LAY %"DSB"%"012/90"%"B501"%7.25%%"TC"%"A"%"GC"%%488%%%% 
#SAM %"DSB"%"012/90"%"B501"%"2967"%"R"%"T"%0.5%%%%%"FILL: SAND, sl. clayey, gravelly, w. mull"%%%%%%%%%False%%%%%%0%0.6% 
#SAM %"DSB"%"012/90"%"B501"%"2968"%"R"%"T"%1%%%%%"FILL: SAND, medium, sl. gravelly, w. gyttja lumps"%%%%%%%%%False%%%%%%0.6%1.2% 
. 
. 
. 
#EOF 

 

Figure 27. Example of a Geoform file. 
 
The Geoform files list the data in tables and in rows. The data fields are identified by their 
sequence in the tables.  
 
GeoXML Files 
 
 
<?xml version="1.0" encoding="iso-8859-1"?> 
<GeoXML VERSION="1.0.0" DATE="20061105"> 
<COM COM="DSB" NAME="DSB" ADDRESS="M&#248;ntergade, (R&#38;H kortnummer 1239)," SYM="1" Active="False" /> 
<JOB COM="DSB" JOB="012/90" TITLE="Nyt opl&#230;ggerleje, R&#248;dbyhavn" DESCR3="a" CSYS1="UTM32ED50" DSTART="19951004 120000" 
DCOMPL="19951004 120000" SYNTAX="B" SETUP="UK" RINI="dev" REV="20040329 111034" MSLINK="6" lck="True" /> 
<BOR COM="DSB" JOB="012/90" BOR="B501" BSYNO="12/90-B501" BDATE="19900502 120000" CSYS1="UTM32ED50" X1="651866" Y1="6058851" LSYS="DNN" 
Z1="2.74" TOP="0" BOTTOM="17.6" PURPOSE="GT" mthd="UK" PHASE="0" RINI="dev" REV="20040329 051729" MSLINK="126" /> 
<LAY COM="DSB" JOB="012/90" BOR="B501" D1="0" D2="7.25" INTERP="TC" SERIES="A" LAYER="LG/PG" MSLINK="482" /> 
<LAY COM="DSB" JOB="012/90" BOR="B501" D1="0" INTERP="M" MSLINK="481" /> 
<LAY COM="DSB" JOB="012/90" BOR="B501" D1="0.6" INTERP="M" MSLINK="483" /> 
<LAY COM="DSB" JOB="012/90" BOR="B501" D1="1.2" INTERP="M" MSLINK="484" /> 
<LAY COM="DSB" JOB="012/90" BOR="B501" D1="2.3" INTERP="M" MSLINK="485" /> 
<LAY COM="DSB" JOB="012/90" BOR="B501" D1="4.4" INTERP="M" MSLINK="486" /> 
<LAY COM="DSB" JOB="012/90" BOR="B501" D1="6.3" INTERP="M" MSLINK="487" /> 
<LAY COM="DSB" JOB="012/90" BOR="B501" D1="7.25" INTERP="TC" SERIES="A" LAYER="GC" MSLINK="488" /> 
<SAM COM="DSB" JOB="012/90" BOR="B501" SAM="2967" STYPE="R" TB="T" D="0.5" DESCR1="FILL: SAND, sl. clayey, gravelly, w. mull" CLTOP="False" 
D1="0" D2="0.6" /> 
<SAM COM="DSB" JOB="012/90" BOR="B501" SAM="2968" STYPE="R" TB="T" D="1" DESCR1="FILL: SAND, medium, sl. gravelly, w. gyttja lumps" 
CLTOP="False" D1="0.6" D2="1.2" /> 
. 
. 
. 
</GeoXML> 
 

Figure 28. Example of a GeoXML file. 
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GeoXML meet the same demands as Geoform files, but are based on a simple XML format. 
The advantage of using GeoXML is that the database fields are specified explicitly. This is 
more safe than using the field sequence as in the Geoform files. 
 
 

3.2.2 Definitions 
 
The different functions in Import, Export and Update are defined in the Import definition 
database. It can be called from the system menu: 
 

 
Figure 29. Calling the Import definition database. 
 
In the definition database, the user may e.g. edit the different SQL expressions: 
 

 
Figure 30. The Import definition database.
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3.3 GIS Export 
 

 
 

 
Figure 31. GIS Export. 
 
The GIS module is used for running large GIS export jobs. The export jobs may be exe-
cuted in groups.  The exported data may be imported to: 
• ArcGIS 9.1 or later 
• MapInfo 8.0 or later 
• Google Earth 4.2 or later 
• GISViewer 
• Shape files 
 
The user must specify: 
• From Database, i.e. the database or file from which data are imported 
• GIS File, i.e. the path to the files to which data are exported 
• Coordinate system  
• The Parameters tab is used to specify special parameters in connection with the indi-

vidual function 
• The Status tab shows continuously how much the individual function has calculated 
 
You start the program by clicking the Execute button and stop it by clicking the Stop button 
in the Status bar: 
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If you select export to MapInfo or ArcGIS the files will open in a new map window. All layers 
will be in the same window. If you select export to shapefiles you can open the file sepa-
rately in e.g. ArcGIS. 
 
Note that you can also export to GIS directly from data grids using the shortcut menu. 
 

3.3.1 Definitions 
 
The different functions in the GIS module are defined in the GIS definition database, which 
can be called from the systems menu: 
 

 
Figure 32. Calling the GIS definition database. 
 

3.4 Search 
 

3.4.1 Standard search function 
 
Standard search based on a data grid window is quickly made by using the standard search 
function: 
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Figure 33.  The standard search function that can be called from all windows. Grey fields are 
calculated fields.  
 
The user may enter up to 10 alternative criteria’s. The Return field is used to limit the num-
ber of result rows. Normally you should not look up more than about 10000 rows. This limi-
tation is especially important in connection with the use of webservices. 
 
The SQL tab contains the criteria in SQL form: 
 

 
Figure 34. The standard search function – SQL window 
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3.5 Plotting Drawings  
 

 
 

 
Figure 35. Plotting borehole logs. 
 
The user may plot drawings of borehole logs, longitudinal sections, laboratory enclosures etc. 
by calling the drawing function. Here you can select the required drawing type and order one 
or more drawings: 
 
• More is used to change the set up of the individual drawing. 
• Order is used to order a single drawing for plotting – double click in the list for fast plot-

ting of a single drawing. 
• Order Selection is used to order drawings of e.g. a number of selected boreholes.  
• Clear is used to delete earlier orders. 
• Execute is used to create the ordered drawings. 
• Exit closes the window. 
 
The plotting scales (Horz. Scala and Vert. Scala) may be changed for each drawing type 
and saved to the next time the window is used. Print? is used to indicate whether the draw-
ing should be sent to the printer immediately.  
 
The user may enter special parameters in the Parameters tab and see the ordered drawings 
on the list in the Order tab. 
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The user may select Standard Drawings by using the shortcut menu in the drawing list. The 
standard drawing is highlighted with blue:  
 

 
Figure 40. Selection of Standard Drawing. 
 
Standard Drawing may be used for fast plotting in the relevant windows: 
 

 
Figure 41. Button for execution of Standard Drawing. 
 
The user may select existing drawings from the drawing list in the tool bar:  
 

 
 
The drawings are shown as standard in the built-in drawing program:  
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Figure 42. Example of a borehole log. 
 
The user may manipulate the drawings by use of the corresponding toolbars and shortcut 
menus: 
 
Drawing Toolbar 
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Drawing Shortcut Menu 
 

 
 

 
Open drawing file 
 

This function allows you to select an existing drawing 
file. 
 

 
Shift tree window 
 

This function turns the view of the tree window on 
and off. 

 First page 
Next page 
Previous page 
Last page 
 

These functions are used for navigating between the 
different pages. 
 

 
Zoom In This function is used for zooming in on the drawing 

by clicking a new centre.  

 
Zoom Area This function is used for zooming in on the drawing 

by selecting a new drawing section. 

 
Zoom Out This function is used for zooming out in the drawing 

by clicking a new centre. 

 
Pan drawing This function is used to move the current drawing 

section. Click and drag. 

 
Adjust This function adjusts the scale so the entire drawing 

is visible inside the drawing window in question. 
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Adjust width This function adjusts the scale in such way, that the 

entire width of the drawing is shown within the draw-
ing window in question. 

 Adjust height This function adjusts the scale so the entire height of 
the drawing is visible inside the drawing window in 
question. 

 
Info The info function gives information about the individ-

ual drawing items, when you run the mouse over 
them: 
 
 

 
 
A click on the drawing items causes a jump to the 
relevant input windows. 

 Refresh drawing from 
file 
 

This function redraws the drawing from the drawing 
file without creating a new drawing from the data-
base again. 

 
Refresh drawing from 
database 
 

This function causes an update of the drawing from 
the database. This is useful if the user has made 
corrections to the corresponding data. 

 Copy This function copies the drawing to the clipboard. 
 

 Black and white? 
 

If this parameter is turned on, the drawing will be 
optimised to black and white printing. 

 
Print preview Show a preview of the print in the window. 

 

 
Print Send the preview of the print to a printer. 

   

 
Dxf This function causes the drawing to be printed as a 

Dxf file, which can be imported to various CAD sys-
tems e.g. AutoCAD. 

 Windows Metafile This function is used to print the drawing in Windows 
Metafile format, which can be read by many drawing 
tools. 

 Bitmap (PNG) This function is used to print out the drawing in PNG 
format. 

   
 Edit Setup This function causes a call of the database that de-

scribes layout and database extract for the drawing. 
 Edit Defs This function makes it possible to edit the symbol 

definition files connected to the drawing. 
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 Edit drawing file This function makes it possible to text edit of the 
drawing file. 

 Clear drawing list This function deletes the system’s list of old draw-
ings. 

 Clear buffer This function deletes imported drawing settings from 
the memory so it is possible to import the updated 
settings again. 

   
 Browser Drawings are printed in SVG format, which can be 

viewed in various browsers. The present version of 
the file format requires that Adobe’s SVG plugin is 
used. This plugin can be downloaded from 
http://www.adobe.com/svg/viewer/install/main.html. 
 

 
Tree window 
 
The tree window in the drawing tool can be used for navigating between the pages and for 
indicating whether the different drawing items should be visible or not: 
 

 
Figure 43. The drawing program’s tree window. 
 
• Pages contain the possibility for selecting the active page. 
• SVG contains the drawing in a hierarchical structure. 
• Defs indicates the standard symbols. 
• Frame describes the drawing frame. 
• Static Content describes drawing items that recurs from page to page. 
• Page Annotation indicates page numbering etc. 
• Scaled Content contains scaled drawing items for example data that varies with the 

depth in connection with drilling profiles.  
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Adjustment of logo 
 

 
Figure 44. Logo Example. 
 
Logos on drawings are most easily given as bitmap files in e.g. png format. The files are 
placed as standard in the folder: ..\Images under GeoGIS2005 in the main folder.  
 
In the background table definition files the placing and scaling of the bitmap files are given 
as in the following piece of the file ..\Lib\hstgdk.svg: 
 
. 
. 
<text x="109.0" y ="-12.0">Dato :</text> 
<text x="145.0" y ="-12.0">Bilag :</text> 
</g> 
<image x="2" y="-9" width="40" height="8" xlink:href="../images/logo.png"> 
</image> 
</g> 
. 
. 
 
Adjustment of drawings 
The different drawings are defined in the database: ..\Access\G05Draw.mdb. The user can 
edit the different settings by calling the page: 
 

 
Figure 45. Call of page for setting of drawings.  
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Figure 46. Database page for setting up drawings.  
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3.6 History 
 
The history module in GeoGIS2005 is used to register the updates different users perform on 
a SQL Server database. That is, each time a user inserts, updates or deletes a database row 
the following is registered: 

• The user, that performed the update 
• When the update was performed 
• Which tables, rows and fields are updated 
• What the field values were before and after the update 
 
The updates are tied together in transactions, for example: 
 
• All rows imported from a data file 
• All rows that will be deleted when the user deletes a project or a drilling 
• All rows that will be updated if the user rename a project 
 
Each time a user logs on to the system a new transaction starts.  
 
The user may subsequently Undo a whole transaction or a single update. 
 
History of a single database row 
 
If you want information about the history of a given database row, you mark the row by 
clicking the row selector in the left part of the window. Then you click the History icon in the 
GeoGIS2005 icon toolbar: 

 

 
Figure 48. The menu for viewing history of a single row.  
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Figure 49. History list of a single update. 
 
Here the user may flip through the different updates performed on the database row. By 
clicking Undo the user can undo an update and return to the former values. 
 
Transactions 
 
If you want an overview of all transactions performed on the database, you can do it by se-
lecting the page: History: 
 

 
Figure 50. Selecting the History page of a given database. 
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Figure 51. List of history transactions. 
 
In the folder: Transactions, the user may see the different transactions together with their 
updates. The user may undo entire transactions or individual updates.  
 
It is possible to start and stop the History function in the system’s status bar: 
 

 
Figure 52. Click on Hist On / Hist Off starts and stops the History function. 
 
The user may like to stop the History function, when doing heavy load operations. Only a 
administrator to the SQL Server database can stop the History function. 
 

4. The Meta database 

GeoGIS2005 is built in a general framework. Behind all windows, there is a number of data 
defining the appearance and the “dialog” between the windows. GeoGIS2005 is delivered 
with a complete set of windows ready for use within soil engineering, water supply etc. The 
GeoGIS2005 framework gives basis functionality to all windows, graphs etc. In principle, the 
framework can be used by all kinds of databases and is consequently not bound to geological 
or environmental engineering data.  
 
The Meta database is a central part of the framework used for: 
• Definitions of tables, fields and relations 
• Definitions of headlines, lead texts and codes dependent on language 
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• Definitions of windows and their mutual hierarchy 
• Definitions of the connection between databases and pages 
 
The Meta database can be called from the System menu: 
 

 
Figure 53. Calling Meta database.  
 

 
Figure 54. Example of table definition in the Meta database. 
 
Meta data for the current window can also be called by use of the shortcut menu:  
 

 
Figure 55. Functions for calling Meta data for a single window. 
 
An important function of the Meta database is to define headlines and lead texts. The user 
may see the actual language (Setup) in the system’s Status bar: 
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The language may be changed by clicking the Setup button. 

5. Description of Functions 

Below is a short description of the functions in GeoGIS2005. 

5.1 The Main Menu 
 

 
 
File 
 

 
Figure 56.  The File menu - used for saving and exchanging settings. 
 
In the File menu, there are functions for saving settings of GeoGIS2005. The user can create 
one or more settings each having a setting suitable for the task in question. A setting defines 
the attached databases and shortcuts.  
 
Window 
 

 
Figure 57.  The Window menu – used for arranging database windows.  
 
In the Window menu, there are functions to arrange open database windows. In case there 
are several database windows open, you will see a list of the windows at the bottom. The 
active window is ticked off. 
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Utilities 
 

 
Figure 58.  The Utilities menu contains the GeoGIS2005’s support tools.  
 
In the Utilities menu, there are tools for processing and visualisation of data.  
The functions are described in detail in section 3. 
 
Help 
 

 
Figure 59. The Help menu. 
 
In the Help menu, there is a link to the GeoGIS2005 homepage and information about the 
installed version. 
 
Manuals in pdf format are listed in the Manual combo box. 
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5.2 Toolbars and Shortcut menus 
 

5.2.1 Database Toolbar 
 

 
 
The database toolbar is used for calling database tools and open database windows: 
 

 
Database Administra-
tor 

Open dialog for setting up databases 
 

 
Import, export and 
update 

Open dialog for data exchange 

 
GIS export Open dialog for export of data to GIS 

 
Search guides Open dialog for predefined search 

 
Own queries Open dialog for creating Own queries 

 

 

Open selected data-
base with standard 
page 

Open a new database window containing data from the 
selected database 

 

 

Open selected data-
base with selected 
page  

Open the selected page in the active database window.  
A page is a predefined collection of for example lists, 
graphs and documents describing a subject/field of activ-
ity. Access to a certain kind of database is arranged in a 
number of “pages”. The pages are called from the sys-
tem’s main menu. 

 

 
 

Show shortcuts in list It is possible to make a shortcut for menu often used. 
Typical shortcuts could be: 
 
A specific drilling 
A specific waterworks 
Newly entered samples of water 
A particular user defined search 
 
“Previous” is the last used menu. The shortcuts can refer 
to different databases. The user can indicate a suitable 
lead text for each shortcut. A specific shortcut can be 
selected as “start-up page”. 
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5.2.2 Form Toolbar 
 

 
 
The form toolbar is used for arranging and editing database windows: 
 

 
Arrange Arrange open database windows in such way that the win-

dows make the best possible use of the screen without the 
windows overlapping 

 
Cascade Arrange open database windows in such way that they over-

lap each other with the title visible 

 
Save updates Save adjustments 

 
Undo updates Undo adjustments performed since last update 

 
Delete selected 
adjustments 

Delete selected rows 

 
Cut selected rows Move/transfer selected rows to the clipboard from where you 

can copy 

 
Copy selected 
rows  

Copy selected rows to the clipboard 

 
Insert copied rows Insert copied rows 

 
Print preview Show a preview of the print on the screen before it is printed 

 
Print Print without preview 

 
Find Open dialog for search in data present in the active list 

 
Find and replace Open dialog for search followed by replace 

 
One level up Select the folder one level above in the tree structure 

 
Change tree win-
dow 

Manage whether the tree structure should be viewed 

 
Change form split 
 

Manage split of the active window. The shift is between 3 
views: Data, data definitions and both data and definitions 

 
Adjust columns 
 

Adjust the column width in the active list so everything is 
visible within the columns  

 
Order a drawing Open dialog for ordering a drawing 

 
Show selected 
data in GIS 

Open GIS – and show selected rows 

 

5.2.3 Drawing Toolbar 
 

 
 

See section 3.5 for a detailed description.



 

Ref. 4694001/GeoGIS2005_Manual_UK_20071205 40/49

 

5.3 Shortcut Menus 
 

5.3.1 The Tree Window 
 

 
Figure 60.  Shortcut menu to the tree menu.  
 
In the right-click menu in the tree structure, there are tools for navigating and changing the 
tree menu: 
 
Refresh 
 

Used for updating the tree menu, if it is dependent on 
entered or changed data. 

New window Used for opening a new database window with the se-
lected node as a new main node. 

Collapse Used for collapsing a node and all related sub-nodes. 

Collapse All Used for collapsing all node. 

Expand Used for expanding a node. 

Create Shortcut Used for creating a shortcut to the selected node.  
See also section 2.3. 

Copy Menu Tree Used for copying the tree structure to the clipboard. 
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5.3.2 Data Window 
 
In the shortcut menu in the data window, there are tools to find data, call functions and ex-
port data: 
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Figure 61.  Shortcut menu to the data window. 

 

 

 
Edit Menu for editing functions 
 - Save updates Used for saving changes. Changes are marked with a turquoise colour. 

Note that also deleted data should be deleted with this function. 

 - Undo updates Used for undoing database updates. 

 - Delete rows Used for deleting selected rows. 

 - Copy selected rows Used for copying selected rows. 

 - Cut selected rows Used for cutting selected rows i.e. they are copied and deleted. 

 - Insert copied rows Used for inserting copied rows from the active row i.e. any existing 
data are overwritten. 

 - Copy and insert rows Used for copying and inserting rows in a workflow. 

 - Insert rows  Used for inserting previously copied rows. 

 - Fill in column Used for filling in empty fields in the active column with the selected 
value. 

Find and Replace 
 

Start the Find and Replace function: 

 
Note that the function can also be used as a search function 
only. 

Filter Filter data in such way that only rows containing the selected 
values are listed. 

Search Start the standard search function. See section 3.4.1. 

Up one level Used for selecting a folder one level above in the tree struc-
ture. 

Refresh data Used for refreshing data from the database. You get the same 
result by double clicking the window heading: 
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Layout Menu for adjusting the window layout 
- Save form settings Used for saving a form setting so the form will open with the same 

setting next time it is opened. 

 - Select main form Used for bringing the main form into focus. 

 - Next form Used for bringing the next form in the database window into focus. 

 - Change tree window Used for changing the view of the tree window. 

 - Change tree window Used for changing between detail and list view. 

 - Change form split orienta-
tion 

Used for changing between vertical and horizontal placement of the 
detail window. 

 - Change window split Used for changing between views of subwindows. 

- Change window split orien-
tation 

Used for changing between vertical and horizontal placement of sub-
windows. 

 - Change main form view Used for changing between view of just the main form or the main 
form including subforms.  

 - Adjust row height Used for adjusting the row height so that all data can be viewed with-
out scrolling. 

 - Select standard row height Used for selecting the standard row height for all rows. 

 - Freeze rows Used for freezing selected rows so they will not move when scrolling.  

 - Release rows Used for releasing frozen rows. 

 - Adjust columns Used for adjusting the column width to the data. 

 - Freeze columns Used for freezing selected columns so they will not move when scroll-
ing. 

 - Shift database toolbar Used for shifting between viewing the database toolbar or not. As 
standard, it is shown.  

 - Shift form toolbar Used for shifting between viewing the form toolbar or not. As stan-
dard, it is shown. 

 - Shift drawing toolbar Used for shifting between viewing the drawing toolbar or not. As stan-
dard, it is not shown.  

 - Use expanded detail win-
dow 

Used for changing the view to expanded detail window. The expanded 
detail window gives the user a possibility to specify how the combo 
boxes should be shown. 

Refresh layout Used for reloading data and meta data and thereby refreshing 
the outlay of a form. 

Print This menu is used for printing. 
 - Print Used for printing out a window to a printer. 

 - Print Preview Used for getting a preview on the screen. 

 - Page Setup Used for changing page setup. 

Export This menu contains functions for export of form data to Excel 
and XML 

 - Excel Used for exporting data to Excel 

 - XML Used for exporting data to XML 

GIS This menu contains functions to export data to GIS. See also 
section 2.5.1 

 - GIS start Used for starting the selected GIS system. As most GIS systems have 
to go through a long upstart procedure, it is most convenient to start 
the GIS system before you send data from GeoGIS2005.  

 - GIS export Used for exporting all table rows in the present form to GIS. 
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 - GIS export selected Used for exporting all selected table rows in the present form to GIS. 

 - GIS centre selected Used for setting focus centres on the coordinates in the selected rows. 
Indication circles are drawn, buy data are not exported. 

Metadata This menu contains functions for listing and updating meta-
data. The functions are primarily used when developing new 
forms.  

 - See form definition Used for listing the metadata that describes the present form.  

 - See form relation Used for listing the metadata that describes how the present form is 
related to other data. 

 - See tabel definition Used for listing the metadata that describes the present form’s main 
table.  

 - Update tabel definition Used for updating the metadata that describes the present form’s 
main table with data from the present database. 

 - Delete buffer Used for deleting the internal form buffer so all meta data can be read 
again as the different windows are revisited. 

 

6. Installation 

6.1 Hardware and Software requirements 
 
The system must meet the following requirements: 
 
• Microsoft Windows XP or later 
• Microsoft .NET framework 2.0 
• Internet browser like Microsoft Internet Explorer 6.0 or more 
 
The customer will provide for purchase and installation of relevant viewers: 
(E.g. Acrobat Reader, DWG/DXF - viewer etc.), Office programs (e.g. Microsoft Excel), data-
base software (e.g. Microsoft Access or SQL Server), GIS software 
(e.g. MapInfo, ArcGIS etc.) and CAD software (e.g. AutoCAD or Micro Station). 
 

6.2 Installation 
 
You may install GeoGIS2005 from the Internet or from CD. 
 
You get the installation package from GeoGIS2005’s homepage: 
www.GeoGIS2005.Ramboll.dk 
 
After the installation, you start the program by using the icon on the desktop: 
 

 
 

6.3 File Structure 
 
GeoGIS2005 will be installed with the following structure:  
 
\GeoGIS2005 Main folder for the program 
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\Access  Contains  various system databases 
\Bin   Contains programs for executing 
\Data  Folder for temp data 
\Db   Standard folder for databases 
\Doc  Contains documentation in the form of PDF files 
\DSCache Contains temporary files for use in connection with Webservices 
\Geoids  Folder for coordinate definitions 
\Images  Contains  various bitmap files used by the drawing program 
\Lib   Contains  symbol files used by the drawing program 
\Map   Contains  symbol files used by the drawing program 
\Script  Contains script files used by the drawing program 
\Work  Work areas 

  
The most important system databases are: 
 

GS05Sys.mdb Meta database 

G2005.mdw Workgroup file for system databases 

GS05AGS.mdb Database for conversion of AGS data 

GS05CAD.mdb Database for setting up CAD extracts 

GS05D.mdb Seed Database for new GeoGIS databases 

GS05Draw.mdb Database for setting up plotting drawings  

GS05GIS.mdb Database for setting up GIS extracts 

GS05Import.mdb Database for setting up import- and export programs 

GS05XML.mdb Temporary database, used when entering standard files 

 
The user can choose any main folder for installation. 
 

6.4 MapInfo Tools 
 

 
 
The GeoGIS2005 MapInfo toolbar is defined in the file: 
 
..\Bin\GeoGIS2005.MBX 
 
The toolbar is normally added to MapInfo automatically if the program is called from 
GeoGIS2005. The user may also add the function manually by using the MapInfo Tool Man-
ager. 
 

6.5 ArcGIS Tools 
 
As standard, the GeoGIS2005 ArcGIS tools may be used for ArcGIS version 9.0, 9.1 and 9.2. 
Contact Rambøll for support of earlier versions.  
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The GeoGIS2005 ArcGIS toolbar is defined in the files: 
 
..\Bin\GeoGIS2005ArcGIS.dll 
..\Bin\GeoGIS2005ArcGIS.reg 
..\Bin\GeoGIS2005ArcGIS-Install.bat 
 
When installing GeoGIS2005 for the first time and when updating the program, the file Geo-
GIS2005ArcGIS-Install.bat will be executed. 
 
Next the toolbar in ArcMap > Tools > Extensions should be activated: 
 
 

 
Figure 62. Activating GeoGIS2005 toolbar in ArcGIS/ArcMap 
 

6.6 Licenses 
 
When GeoGIS2005 is installed on a PC and executed for the first time, it is provided with an 
installation number. The user must have a corresponding set of license numbers before being 
able to use the program.  
 
How to obtain license numbers is described in detail in section 3.1.4. 
 

6.7 GeoGIS2000 databases 
 
GeoGIS2005 can exist together with earlier versions of GeoGIS2000 and work with the same 
databases. There is no problem with running both versions in a transition phase. 
 
When installing GeoGIS2005 the user can choose to enter the attached databases from the 
GeoGIS2000 installation. In this way, the user will find it easy to get started with the previ-
ously used databases. 
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7. User Support and Forum 

The address www.GeoGIS2005.Ramboll.dk gives access to a user forum for registered users 
and possibility to get new versions of GeoGIS2005 etc. 
 

7.1 Download of GeoGIS2005 
 
The Internet address: www.GeoGIS2005.Ramboll.dk gives access to the user support page: 
 

 
Figure 63. GeoGIS2005’s homepage. 

By clicking Download, it is possible to download installation files and license conditions: 
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Figure 64.  Download of new versions and updates to GeoGIS2005. 
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By clicking Download, you can save and subsequently install the installation package: 

 
Figure 65.  Installation from download page. 

 

7.2 Forum 
 
By click on Forum, you get access to GeoGIS2005’s user forum, where it is possible to find 
answers to your questions, ask questions yourself or comment other GeoGIS user’s contribu-
tions and questions. 

You get access to GeoGIS2005’s user forum by registering as a user on 
www.GeoGIS2005.ramboll.dk with user name, password and e-mail. It is important that the 
e-mail address is identical to the one used when installing GeoGIS2005 – See the description 
of the Database Administrator – Licenses tab, section 3.1.4. 

The forum may also be called from the help menu in GeoGIS2005. 


